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Overview

Sources of Information on Collector’s Assistant

There are a number of sources of information regarding use of the
Collector’s Assistant.

e This Manual - this manual describes most functionality accessible
within the Collector’s Assistant
e Carlisle Website (www.carlisledevelopment.com)

o Technical Support - Frequently Asked Questions — provides
answers to many commonly asked usage questions,
organized by category

o Technical Support - Tips & Techniques - provides more
indepth descriptions of some functions

o Technical Support - Video Tutorials — provide brief videos
which illustrate some common operational sequences

Organization of this Manual

This manual is organized in order so that topics of most interest to all new
users are in the early chapters, followed by more advanced topics which are
more likely to be of interest to user who have mastered the basic operations
and wish to exploit some of the advanced functionality of the Collector’s
Assistant or customize their user experience.

Chapter 1 defines important terminology user throughout this manual.


http://www.carlisledevelopment.com/

Chapter 2 defines the major elements of the User Interface
Chapter 3 focuses on the essential tasks needed to catalog your collection.

The remaining chapters cover specific topics in greater detail such as
printing, searching, setting user preferences and customizations.



What's New in Version 10

Version 10 is data compatible with versions 8 and 9 and builds on this
platform with the addition of substantial functionality:

RealValue Pricing — The user may now specify rules to adjust the value
in order to get a better sense of liquidation value. Rules may be
defined based on value and scarcity

How To — We have added a major new section under the Help Menu
consisting of detailed instructions on a variety of functionality, both
basic and advanced. This is intended to provide the best source of user
instruction. The How To topics are user customizable using a text
editor and also will be extended by us periodically. It will also be used
to provide customized instruction.

User Interface Enhancements — We have eliminated the Guide to
Common Actions and replaced it with direct control buttons for the
most commonly used functions (adding items, setting sort order,
printing, searching.

Automatic Repair — The Collector’s Assistant has the capability to
repair a few of the more commonly occurring problems.
Synchronization with mobile devices — During 2013 we will be
releasing mobile versions of the Collector’s Assistant. Version 10 has
the ability to synchronize data with mobile versions.

URL associations with items in your collection — You may now save up
to 10 URL’s per item in your collection and link to them directly on the
internet.

Database segment of US Medals - We have added a new database
segment for medals issued by the US Mint and populated it with recent
medal issues. We will be keeping it current going forward and over
time we plan to add earlier issues.

Standard Database Window is now visible in an abbreviated version
(no pictures/values) so that it obscures less of the current collection.
User Working Directory may be changed at any time.



Chapter 1: Terminology

There are a few basic terms which will be used throughout the manual.
Please take a few minutes to review this terminology:

e Controls & Selection Area - this is located along the left portion of the
Collector’s Assistant window and enables the user to select their
collections and also User Preference settings. Collections are organized
into groups (initially all collections are in the group My Collections). At
the top of the Controls Area are function button to access the most
important functionality. A few of these buttons may be hidden in order
to provide more vertical space for listing of the collections.
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Action Bar or Menu - located along the top of the Collector’s Assistant,
this is used to access most functions available within the Collector’s
Assistant. One choice on the menu “Guide to Common Actions”
provides controls for manual data entry when required.
Collection Display Window — When you select a collection, a new
window will appear, displaying the contents of that collection. This
window contains two major sections, divided by a horizontal splitter
bar:
o Collection Listing Grid — a columnar display containing 1 row per
item in the current collection, with user customizable columns
o Tabbed folders — used to display and edit all information for the
item that is currently selected in the Collection Listing Grid.
Dropdown or Choice List — these controls used widely throughout the
Collector’s Assistant are used to select from among a group of existing
choices and/or enter new choices
Status Bar - located at the bottom of the main Collector’s Assistant
window, the status bar displays the totals of the current collection or
the Grand Totals of all collections.



Chapter 2: User Interface

The user interface of the Collector’s Assistant consists of several major
components:

e Action Bar/Menu - Located along the top border of the Collector’s
Assistant, the action bar (menu) provides access to most functions
available within the Collector’s Assistant. It consists of a static portion
of choices which are always available as well as additional choices that
appear when a collection is displayed.

e Controls Area - Located along the left hand border, this provides for
selection of the collection to be worked with as well as user
preferences. It also includes the most important function buttons.

e Windows area - the remainder of the interface consists of a large area
in which windows will appear:

o Collection display windows - each time you select a collection, a
new window will open containing a display of that collection

o Search results window - a window displaying items from all
collections meeting search criteria

o User Preference settings — each user preference area opens a
window when selected

o Specialized function windows - a number of other operations
(Collector Tools, etc) will open new windows.

e Status Bar - displays collection totals at bottom of Collector’s Assistant
main window



Action bar/menu

Static Menu Choices

e Controls - determines the width of the controls area

Hide - controls area width set to 0 (hidden)

Show - controls area width set to default value

Expand - controls area width set to wide setting

Add Collection Grouping - new function in V9, allows user to

create new collection groups

e View - determines what user data will be presented in controls area
and also provides direct access to view standard databases if available
for your collectible.

o Database - opens a window with a collectible selector for those
collectibles that are part of your Collector’s Assistant package.
Available databases include Coins (United States, World),
Ancient Coins, Casino Chips, Paper Money (United States, World)

o User: MyData - this is the default user

o User: xxxx - additional users will appear if created

Selecting a user will populate the collections group of the controls
area, User: MyData is automatically created and selected on
installation of the Collector’s Assistant.

e File — accesses backup and restore and history sub menus

o Backup & Restore - opens a window providing backup and
restore functionality as well as move to a new computer
functions.

o History

» Create history record - saves a summary of collection
statistics (maximum frequency of once per month)

= View history - tabular and graphical presentation of history
records

o Exit - closes the Collector’s Assistant

e Find - access to search functions

o New QuickSearch - displays the search window which allow the
definition of adhoc or saved searches

o Saved QuickSearch - accesses a submenu of previously defined
searches

e Print
o Current Collection - prints the current collections

o O

O



o
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Current Collection - Selected Items - prints only the selected
items in the current collection

Selected Collections — Summary - prints 1 line of summary
information for selected collections

Selected Collections — Detailed - prints all items in a selected
subset of collections

All Collections — Summary - prints one line per collection with
summary information

All Collections — Detailed - prints all items in all collections
Setup Printer — accesses print driver settings

Collector Tools

o

o

o

Analyzer

Grading Assistant — accesses the Grading Assistant if available
(separately purchased product)

Coin Type ID/Mint Mark Locator - gallery of US coin types by
denomination with graphic overlays indicating position of mint
marks.

Coin Variety Identification - gallery with graphic overlays of
common coin varieties (small date, large date, etc)

Toned Coin Image Gallery - gallery of attractively toned coins
Insurance Planning - accesses function presenting blanket and
individual item insurance information

Estate Planning — accesses function to manage heirs and estate
allocations

(Only if Survival Manual installed) Survival Manual Tools

(Only if Top 100 Morgan Varieties installed) Top 100 Morgan
Tools

Collector’s Assistant-Bullion Content - generates a text file with
the detailed bullion content of your collections.

(Only if Bullion Analyzer installed) Bullion Analyzer Tools

Updates

o

Apply Value Update to All Collections — processes each item in
every collection and applies the latest market values (used after
downloading a new value update or importing items from
another product)

Updates - Online updates (subscribers) — accesses online
database and market value update subscriptions



Recalculate All Totals — assures that all calculated fields on all
items in all collections are up to date

Change Path of Attached files — used to reconnect attached
pictures and documents if they have been relocated to another
location on your computer.

About - displays product version and contact information
Auto Repair — accesses diagnostics and auto repair functionality
How To - accesses new How To topics.

Guide to Common Actions

(@]

Add Item to Collection - displays standard database or adds
contents of the tabbed folders as a new item if “manual entry” is
checked

Create New Collection - displays Guide to Common Actions so
that user may create a new collection

Manual Entry — determines action of Add Item to Collection -
normally unchecked causes standard database to display

Clear Fields on Add - for manual entry, causes tabbed folders to
clear out after a new item is added

Mobile Synchronization

o

Check for Mobile Data - used to see if updated data has been
entered in a mobile device

Export to Mobile Device - used to provide a data update to a
mobile version of the Collector’s Assistant.



Dynamic Menu Choices — appear when a collection window is

visible

e Collection — a group of functions which operate on the currently
selected collection window

©)

Save Sort Order - Associates the current selected column sorts
as the default for the current collection. This sorting will
automatically be set each time the collection is opened.

Select Listing Format-> - displays a submenu of existing listing
formats, any of which may be selected. The listing format
controls the content of the Collection Listing Grid

Totals - used to include/exclude a collection in the totals
Redisplay Collection - causes collection to redisplay with
standard sort order selected, values and all totals updated
Print Preview - displays the current collection in the print
preview window

Move Collection to Group - used to move a collection between
collection groups

Delete Collection - deletes the selected collection

= NOTE 1: this menu function is the only way to delete an
entire collection within the Collector’s Assistant. In fact,
the collection is not actually deleted, rather it is moved
into the folder History under My Collections. The collection
may be recovered by using Windows My computer to
relocate the file back to the My Collections folder.

» NOTE 2: Right clicking on a collection name in the
Collection group displays a context menu with two choices,
rename and remove. The remove is temporary and the
collection will be back when the Collector’s Assistant is
restarted.

Update Numismatic Data - processes all coins in the current
collection updating the numismatic data with the most recent
information in the standard database. This function should be
run after downloading US Coin Database listing updates.

Export Data to Delimited Text File — places the selected items in
the current collection listing grid in delimited format into the file
c:\CollectorAssistant\MyData\CAExport.txt for export to MS
Excel and a variety of other spreadsheets and databases.



o Import Data from other Applications — displays the Import
window which allows a user to bring in a tab delimited text file
and import its contents as items in the current collection

o Merge Coins with Standard Database - attempt to recognize
imported or manually entered coins, and if identified merges
them with the information in the standard database

e Item - a group of functions which operate on one or more items in a
collection

o Copy - marks one or more items for a copy operation

o Paste - adds new items from the previous copy operation

o Delete - deletes one or more selected items from the current
collection

= Note - this is the only means of permanently deleting
items from a collection. Clicking on the Delete key on the
keyboard will only temporarily remove items from the list.
They will return when the Collector’s Assistant is re-
displayed.

o Move Items - moves a group of selected items to a specified
destination collection

o Attach Document to Item - allows an RTF document to be used
to populate the note field.

o Modify Selected Items - used to make a common edit to a group
of selected items.

Select All - highlights (selects) all items in current collection
Internet Links - used to attach or link to URL's associated with
items in your collection.

e Values

o Display Values Table - displays a table of grades and values for
the currently selected item (Note - it is possible to have the
values table always appear automatically)

Hide Values Table - hides the values table
Values Changed
» By More Than Percent - highlights all coins whose value
has changed by more than a selected percentage (green
for increase, red for decrease)
» By More Than Amount - highlights all coins whose value
has changed by more than an absolute amount
» Clear Highlights



o Display Historical Values displays a tabular presentation, which
may be graphed of the values trends for the currently selected
coins

o Hide Historical Values - hides historical values table and/or
graphs

e Format Listing

o Add/Remove Column - accesses listing format customizer with
simpler UI for specific purpose of add/removing columns

o Change Grid Settings — accesses listing format customizer with
simpler UI for grid settings

o Customize Listing Format — accesses listing format customizer
with full functionality

e Undo - undo menu for undoing recent operations

o Edits to Currently Selected item - undoes recent edits to one
item
Remove most recently added items
Restore most recently deleted items
Restore most recently deleted collection



User Interface Settings that may be remembered

The following settings may be made by the user and permanently remembered until
changed (Requires V8.1.1 or above):

e Size/Location of main Collector’s Assistant window — automatically
remembers any time borders are moved. Note-maximizing the window will
not be remembered, so to have the window open as large as possible, move
the borders out by dragging them when the window is NOT maximized

e Size of windows that appear as collections are opened.
o Open a collection and adjust its size by dragging the borders

e Location of horizontal splitter bar in a collection window (separates tabbed
folder from collection listing grid) and also whether or not market values
table is displayed. - These will be remembered automatically when a
Collection window is resized.

e On opening the Collector’s Assistant, what collection groups will be expanded
o All - all collection groups expanded
o None - no collection groups expanded
o Name of specific group (for example, My Collection) - only that group
will be expanded, all others will be closed.

e Standard Database window size and whether or not Pictures/Values are
displayed - set by displaying database and clicking on Save Window Settings

Note: Some setting changes will not take permanent effect until you exit and re-
enter the Collector’s Assistant.



Chapter 3: Cataloguing your collection

In the Collector’s Assistant, collections are used to organize your items into
logical groupings. For collections, consisting of several hundred items or
less, all items might be grouped in one collection, but for collections
consisting of thousands of items, it will usually be advantageous to group
items in smaller collections.

For example, a coin collector might have collections such as Gold Coins,
Morgan Dollars, etc. whereas a Book Collector might have collections named
First Editions, Children’s Books, etc)

There is no correct way to organize your items, rather you should choose an
organization which reflects how you organize things.

There are three basic operations needed to catalog your collection:

e Create a new collection
e Add Items to a collection
e Edit Information pertaining to an item already in a collection

Create a Collection

All controls required to create a new collection are located at the top of the
Controls area at the left of the product.

e Click on "New Collection” button (you may need to click on Show
Actions if it is hidden

e Select the collectible type (example, coins) in the dropdown provided
(note - this step is not required for Collector’s Assistant’s containing
only support for one collectible such as the Coin Collector’s Assistant,
in which case the dropdown will not be visible).

e Enter a name for the new collection

e Click on Enter

e If needed, you may create additional collections. When you are done
adding collections click on the Done/Cancel button.



The collection will appear in the controls area under the grouping My
Collections or under the currently selected collection group (if the user has

added collection groups). In the illustration below, the user has added a
collection group named Dollars.
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Adding Items to a Collection

Once you have a collection, you will want to catalog the items that it will
contain. There are two ways to add items to a collection:

e Copy items from one of our standard databases
e Manually enter items

In general, if a standard database is provided, items should always be
copied. For items which are not contained in a standard database, manual
entry will be required.

e Copying Items from a Database:



Select the collection in the controls area
Click on “Add Coin” button located at the top of the controls
area. This will display the standard database.

o Select the database category (such as Dollar-Morgan) A list of
items contained in that category will appear)

o Select items (s) to copy and click on “"Copy to Current Collection”
button located within the Standard Database window.

o Repeat as needed and then Close the database window by
clicking on the close icon in the upper right corner

Note — new in V9, is the ability to enter user data such as cost, grade,
etc while the item is being copied from the database, as illustrated om
the following illustration.

All coins added will have their fields populated with any user data. You
may clear the user data fields by clicking on Clear User Data.
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e Adding Items Manually



o Click on the “"Guide to Common Actions” choice on the menu and
check the preference “"Manual Entry”
Enter the desired information in the blue tabbed folders
Click on “Add Coin” button.

Note when adding items manually, there is a preference under “Guide to
Common Actions” on the menu named Clear Fields on Entry which
determines whether or not the information fields on the tabbed folders are
cleared when an item is added. If you are adding different items, clearing
may be most efficient. If adding very similar items, it might be best to leave
the fields populated with the data for the last item.

There is a check box in the Standard Database window labeled Only Show
Items not in Current Collection. If checked the database listing will be
limited to items not existing in the current collection. The columns (Date,
Mint, etc) displayed in the database listing are controlled by the listing
format “"Database” which may be user customized.

You may print the current database listing by clicking on Print Database.

Editing information about an item

Edits to an item in one of your collections are made by selecting it in the
collection listing grid (which will populate the blue tabbed folders) and then
editing the desired fields on the tabbed folders. Edits occur in real time.
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Collection Groups

You may wish to organize your collections into groups. For example My Best
Coin Albums, Sold Coins, etc. Each group will appear separately in the
controls area and may be expanded or contracted. With respect to collection
Groups:

e Each group maintains its own grand totals
e (Collections may be moved between groups




Items may be moved between collections in the current group (Note to
move items from a collection in one group to a collection in another
you must temporarily move the collection so it is in the same group)
Unique inventory codes, if in use are assigned for each user without
regard to what group a collection is located within.

Cross-collection reports utilize the current selected group

Find operations use the currently selected group

To create a collection group:

Click on Controls->Add Collection Grouping
Enter a name in the box provided and chiclg_ on Add Collection Grouping
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The new group will appear immediately above the User Preferences Group

You may Remove or Rename a collection group by right clicking on it and
then clicking on Rename Group or Remove Group. You may only remove a
group if it has no collections. If you wish to remove a group containing
collections, you must first move all collections to another group or delete the
collections.



Chapter 4: Display and Print Your Collections

The Collector’s Assistant contains extensive capability to view and print your
collection data.

Collection Listing Grid

The Collection Listing Grid displays the currently selected collection in a
spreadsheet like format consisting of one row per item. The user may control
the content, grouping sorting, and formatting of the grid. When a new
collection is created, no sort order is specified so new items will be added at
the bottom and the items will appear in the order in which they are entered.
You will probably want to set the sort order so that items appear as you
would like.

Print button on Controls Area

If a collection is currently open, clicking on the Print button will immediately
send it to the printer, otherwise the Report Manager will appear.

Grouping and Sorting

There are two ways you may specify how items are ordered within the
Collection Listing Grid. Either by direct manipulation of the column headings
or clicking on the Sort Coin button at the top of the controls area. Clicking
on the Sort Coin button will provide dropdowns to select up to 5 sorts and 1
grouping as well as a Save button.

Grouping and sorting may also be accomplished by direct manipulation of
the grid. You may drag a column heading to the area above the grid which
will then cause all items sharing the same value to be grouped together.

Sorting is accomplished by clicking on a column heading. Multiple sorts can
be accomplished by holding down the shift key as you click on column
headings in the order in which sorting is to occur. You may save a sort by
clicking on Collection->Save Sort Order.

Note - the order in which data is catalogued is not important. The
sorting/grouping which may be changed at any time enables you to view and
print the data in the desired order.

Format of Collection Listing Grid



The format used to display the Collection Listing Grid determines:

What information fields are included
Column order and width

Numerical formatting and text alignment
Column text color

Subtotal options

Collection Listing Grid Menu - accessed by right clicking on the grid
or by clicking on Format Listing on the main menu

Right clicking on the Collection Listing Grid will display a context menu for
manipulating the Collection Listing Grid:

Select Listing Grid Format - displays a windows which can be used to
select an existing listing format as well as modify or create new ones.
Clear Groups and Sorts — Removes all assigned groups and column
sorts — collection is then displayed in the order in which the items were
added.

Show Sets only - if the current collection contains sets (containers
with multiple items) each set is represented by one row representing
the aggregate information for the items it contains.

Show subitems only - If the current collection contains sets, only the
items in the sets are listed

Show Sets with Subitems - each set is represented by a top row
reflecting the entire set, followed by the individual items

Add SubItem - opens the standard database in a mode in which items
are added as children of the currently selected set.

Add New Set - adds a parent lot with the expectation that individual
subitems will be added later.
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Collection Listing Formats

The customize listing format dialog allows the user to select and modify
listing formats. Listing formats determine the contents and appearance of
the Collection Listing Grid. Using this dialog, the user may:

e Add columns

e Delete columns

e Re-order columns

e Change Column Width

e Change Column color

e Change the font used for the entire grid

e Include subtotals at bottom of listing and at main sort changes
e Determine alignment and numerical format of text

e Specifies landscape mode when the format is used for printing
e Include a footer with page number

e Include a text page header including collection name and date

Changes made to a listing format affect all collections which use that format.
The user may create and modify as many formats as they wish. Two formats
are provided which may be customized but not deleted:

e Standard - the default format used for a newly added collection
e Database - the format used for a standard database



Right-clicking on the Customize Listing Format dialog hides this dialog when
you have finished your customization.



Chapter 5: Find Item in Your Collections

The find function allows the user to specify a multi-parameter search and
displays a single window containing all items from all collections meeting the
specified search criteria

Searches may also be named and saved for reuse as QuickSearches.

Clicking on “Find” at the top of the controls area or Find->New Search on
the menu displays the search windows. The first step is to select the
collectible in the dropdown provided. This will populate the search frame
with the information fields which have been identified as search fields.

" 4 Search Cr'iteria Selectioﬁ (right-click to 'close search window)
Select Collectible

Find ltems Meeting Criteria More ___

i
[«]

Save QuickSearch
Delete QuickSearch

The most common search fields are displayed. Additional search fields are
displayed by clicking on “"More...” You may include as many parameters as



you want to include in the search criteria. Items that will be displayed must
satisfy all search criteria. To include a parameter select the test to be used:

items greater than the entered value

items less than the entered value

e = items equal to the enteredvalue

e Between - items between two specified values

e Contains - strings containing the specified substring
e >= items greater than or equal to the specified value
e <= jtems less than or equal to the specified value

>
<

Most tests require entry of value, however when you select between, a
second box will appear for the second value.

Once you have defined a search, you may save it for reuse. To do so enter a
name for the search in the dropdown labeled “Select Existing QuickSearch or
Save a New One” and then click on Save QuickSearch. Saved QuickSearched
can be selected once the Search window is displayed or directly from the
main Collector’s Assistant menu where they will be listed under Find->Saved
QuickSearches.

Once you have defined or selected your search criteria, click on the button
“Find Items Meeting Search Criteria” to display the results.

Results will be displayed using the selected Listing Format including items
from all collections meeting the specified search criteria. In addition, the
leftmost column will be added to include the Collection Name so that you will
be aware of where items are located.

Once the search results are displayed, you may:

e Print the results using Print->Current Collection

e Hide the parameter window by right clicking on it

e Manipulate the results grid by grouping or sorting the results. For
example, dragging the Collection column heading to the group area at
the top will group the results by collection.

Note for checkboxes, the parameter must be set to Yes for checked or No for
not checked.



Chapter 6: User Preferences

Located at the bottom of the controls area on the left side of the Collector’s
Assistant is the Group User Preferences consisting of a number of user
defined items:

e User Interface - settings which determine how the collection window
will open as well as some features of the main Collector’s Assistant
window

e Printing - global printer margins and font selection

e Colors - used to set background colors for tabbed folders and controls
area, may also be used to change font size of tabbed folders

e Values - automated value logic, currency formatting and precious
metal spot values

e Choice Lists - maintenance of contents of all preloaded dropdown lists

e Users and Folders - used to add users and manage passwords

e Contacts - accesses a database of contact information for contacts of
interest to the user. Includes direct hyperlinks to websites

e Inventory Code Management - activates automatic number
assignment to each item catalogued

e Data Entry Screens - Customization — allows user to add, relocate,
modify and delete information fields located on the tabbed folders

e Conversions (V5-V7) - brings in data from earlier versions of the
Collector’s Assistant

User Interface

User Interface Complexity — Determines if more than one collection window
is displayed at one time and also if tabbed interface only has one tab. Note
all users should start with the full UI. A one tab setting requires
customization of the data entry fields to include the desired fields on one tab
(contact Carlisle Development tech support)

Editing/Adding New Items - This section contains the preferences which set
the default states of the preferences that affect the addition of items to a
collection. There are two settings:

e Display Database Selector when clicking on Add New Item -
determines whether you are normally addition new items by copying
items from the database or manually entering them



e Clear Fields on Add - determines whether all information fields on the
tabbed folders are cleared after adding an item. When adding very
different items, it is usually best to clear fields whereas, if you are
adding items with many common fields it might be best to use the
information from the last added item as a starting point for the next.

e What collection groups will be expanded when the Collector’s Assistant
is started (All, None, or a specific group — My Collections is the default)

e Two checkboxes (added in V10) allow you to determine if the User
Preferences group opens in a collapsed state and also to Hide the More
Actions buttons on startup.

o User Interface IEI e

User Interface Com plexity
@ Multiple Windows @ Full Ul - all tabs

® One Window at a ime @ Simple Ul - one tab (requires interface customization)

EditfAdding New Item Preferences Use 36DPI Resolution

Clear Fields on Add - After adding a new item all information fields on the
tabbed folders will automatically clear

Display Database Selector on Clicking New Item - if unchecked clicking on New ltem
will add a new item using the contents of the tabbed folders.

Collection Group to Expand when Collector Assistant
starts (All. None. orspecific Group Name)

Collapse User Preferences Group on Start

Hide More Actions buttons on Start

Printer Settings

Sets the default global printer margins for all printed reports. You may set
the left and top margins in inches. The defaults are .25” for both.



Default font to be used for title/trailer pages

Default Paper Margins Left (inches)
Top (inches)

Default Font for Title/Trailer Pages

Value Preferences

This section contains includes preferences related to the automatic value
calculation algorithms as well as currency display format.

e Bullion Spot Prices — used to calculate bullion values for coins for
which this is relevant. User may specify desired prices for gold, silver,
Palladium and platinum. Bullion values are calculated in two cases.
Most US gold and silver issues and coins in the World Bullion Gold and
Silver databases.

e Automatic Value Option - the Collector’s Assistant uses a 5-level value
calculation.

o User entered value - if the user checks the Manual Value
checkbox for a coin, the user entered value always takes
precedence and all other algorithms are not employed.

o Exact Coin World grade match - if the user has not checked the
Manual Value checkbox, if an exact grade match is found, the
associated Coin World value will always be selected for Unit
Value.



o Slightly Lower Numismatic Grade - if an exact match is not
found for the user specified grade, and a suitable lower nearby
grade has a value, this value will be used if the algorithm is
enabled.

o Bullion Value - If a Coin World value is not available, either for
the exact grade or a nearby lower grade, the bullion value will be
used for some silver and gold US issues.

o Face Value - the final choice for all US coins if none of the earlier
algorithms produce a value.

e Bullion value preference - to use bullion value if higher than Coin
World.

e The checkboxes allow the user to globally disable the use of lower
numismatic grade, bullion and/or face values. When the alternate
values are used, the Value Info box of an item provides identification
of the value algorithm used.

e Note - for users who installed the optional CDN values, additional
checkboxes will appear allowing you to determine value precedence as
it relates to Coin World vs CDN.

Currency Value Format

The user may specify prefixes and suffixes to be used for the display of
currency fields. The default is the prefix “$” and no suffix.

To change any of the preferences, make the necessary selections and click
on Save Changes.

Advanced Settings - This button takes you to the rules used to compute
RealValue. You may specify individual multipliers for coins falling within
certain value ranges and also multipliers for coins you define as scarce. You
may also specify a threshold value below which coins will be valued at
bullion or face. The results of these rules will be applied to the new
RealValue field and not affect the Unit Value or Lot Value.



Bullion Spot Prices sivee  ESHENEEE Fatioom

Automatic Value Options

Lower Numismatic Grade
Bullion Value

Use Bullion if higher than numismatic value

Multiplier (Raw)
Multiplier (Certified)
Prefix (Currency)
Suffix (Currency) _

Advanced Value Settings
e automatic values supplied by Coin World represent
ation of i

ntains a second field labeled TrueMarket Value which is intended to provide a
more accurate estimate of the proceeds you would receive sale of items in your
collection.

ttings below may be used to determine how this value is calculated as a
ntage of the Coin World value.

Multiplier for Scarce Coins (default = 1.0):

Multiplier for Common Coins worth less than $100 (default = .65):
Multiplier for Common Coins worth $100-$500 (default = .75):
Multiplier for Common Coins worth $500-$5.000 (default = 80):

Multiplier for Common Coins worth more than $5.000 (default = 85

Assign higher of bullion or face value to all coins worth less than ($):




Choice Lists

All dropdown lists throughout the Collector’s Assistant may be maintained in
this section of the User Preference Area.

QuickAdd Mode - This preference determines what happens when a user
enter information in a dropdown list which is not already present on the list
of available choices.

e Do not ask, add
e Do not ask, do not add
e Always Ask

The remainder of this section allows the user to add, delete and modify
choices on any of the lists. Choice lists are organized by Collectible Type, for
example choice lists such as Coinage Metal, Denomination fall within the
collectible Coin. A special group of non-collectible specific choice lists falls
within the category Shared. This includes buyers and sellers, locations and
containers.

To modify a choice list, you:

e Select the Collectible Type or Shared - this will populate the Select
Choice List dropdown with a list of the choice lists for that category
e Select the choice list to be modified - this will populate the choice list
entries dropdown with the current choices.
e You may then:
o Enter a new choice name and click on Add Choice
o Select an existing choice and click on Delete Choice
o Select an existing choice and modify its name or value and click
on Modify Choice.

The Choice Sort Value is used for the purpose of sorting when an alphabetic
or numerical sort will not produce the desired result. This is used within the
Collector’s Assistant for the Grade field. Each grade is assigned a value
indicating its correct order and the value is the basis of sorting and also
searching.



Select Collectible Type (or Shared for collectible
independent choice lists suchas buyers or locahions)

Select Choce List

Choice List Enines

——

Choice Sort Value -

Quick Add Mode © Do not ask. add
@ Do not Ask. do not add

@ Always ask

User and Password

On installation, a default user MyData is created and a single folder contains
all user collection data. Some users will wish to password protect their files
and others may wish to segregate their collections into different folders. For
example, a family with several coin collectors might create several users.

To Add a new user: Enter a name for the user in the dropdown to the right
of the Add User button and click on Add User. A new folder will be created
and the entered user name will be added to the View choice on the main
menu of the Collector’s Assistant.

To set a password - select the user in the dropdown provided and then
check the password protection checkbox, next click on Modify Password
which will enable you to define the password to be used for this user.



e T Folor

|

MCollectorAssistant \MyData\|

[ Password Protected

IMPORTANT: All newly added user folders are created as subfolders to the installation folder
of the Collector’s Assistant (the default is C:\CollectorAssistant\). Having all user folders as

sub-folders is strongly recommended as it enables full functionality of the PackNGo function
for moving to a new computer and also full backup functionality.

Some highly sophisticated users may wish to create user data folders in other locations.
There is a procedure to allow for this with the understanding that the user will then need to
backup such folders outside of the Collector’s Assistant. The procedure below should only be
used by users highly familiar with the creation and movement of folders using Windows My
Computer

To create a new user with a folder on a different location, the following steps are required:

Enter the name for the new user (this will result in the working directory
automatically generated under c:\CollectorAssistant)\

Modify the working directory (for example by changing the drive from c: to d: and
eliminating the portion of the path that is CollectorAssistant

Click on Add New User

Close the Collector’s Assistant

Move the subfolder that was added outside of the folder c:\CollectorAssistant\ to the
intended location

Start the Collector’s Assistant, Select the new user and add your first collection. If
you are not able to add a collection or see collections of other users listed, the
connection the folder is not where expected. Make sure that the folder location
corresponds exactly to the user working directory.



Contacts

This section allows the user to maintain a database of useful contacts for
their collecting interests. It is preloaded with a small number of industry
sites. If web URL’s are provided, you may directly display a website from
within the Collector’s Assistant by selecting the contact and clicking on the
Connect to Website button. Use of the internet feature assumes the
availability of Internet Explorer which is not installed by the Collector’s
Assistant installation.

elect contact

Company
Name
Address

CountP/ Zip/MailCode -

Phone(Home)
Phone(Cell)
Phone(\Work)

E-Mail

veeste |




Inventory Code Number Assignment

Some users may wish to have the Collector’s Assistant assign a unique
number to each item in all collections. In this preference section, you may
activate this autonumbering feature, while specifying the following options:

e Starting number - on activation, all existing items in all collections will
be assigned a number, starting at the user specified values. Once this
code is activated, newly added items will be assigned the next number
in sequence.

e Prefix — the user may have no prefix, enter a manual prefix for each
item, or have the Collector’s Assistant automatically prefix the
inventory code with the first four letters of the collection in which the
item is located.

Note - once assighed numbers are not re-assignable, except for entry into
the User Assign # field and use of the Transfer button. This feature provides
a means by which a user may force the inventory code number of existing
items by entering the desired values in the User Assign # field and clicking
on Special Feature: Transfer User Assign # to Inventory Code. (nhote there is
no checking for duplication or any other user errors). Deleted items will not
result in reuse of the original numbers.

a5 Inventory Code Assignment [ | =S|

Automated Inventory Code Assignment

You may have the Collector's Assistant assign sequential inventory codes to all items
as they are added. You may also specifiy a prefic option as either user entered or the
first 4 characters of the Collection Mame. If you wish to activate this feature, click on
the check box below. select the prefix option and click on Renumber All ltems.

Inventory Code Prefix

@ User Assigned
@ Collection Name (First 4 Letters) Save Changes

ctivate automatic inventory code assignement - note any previous
ntory codes will be lost.

Starting Number: !
W Only renumber if current code is 0 Renumber All ltems

Special Feature: Transfer User Assign # to Inventory Code




Data Entry Screen Customization

Using this facility, the data entry screens for a collectible may be completely
customized. This is an advanced facility which requires some degree of
comfortability with computers and software. For customers wishing to
customize their screens who do not feel comfortable with computers, Carlisle
Development offers a low cost customization service where many typical
requests can be fulfilled for less than $25.

If you are running Version 8.1.3 or later, whenever the Data Entry
Customizer starts it is in safe mode. In this mode the Modify Field and
Delete Field buttons are disabled. While in this mode you may safely:

e Reposition fields by dragging their labels around

e Increase or decrease the distance between a label and the field to
which it is attached

e Add/Delete/Relocate/Resize pictures

e Move fields between the first three tabs (Item Detail, More Detail and
Buy and Sell

e Add new fields

You may leave Save Mode by unchecking the Safe Mode checkbox. This will
activate the Modify Field and Delete Field buttons. IMPORTANT - You must
not delete or modify fields provided as a part of the standard Carlisle
Development interface. If you do not wish to use some of these fields, it is
recommended that you drag them to the bottom of one of the tabs below
the area that is normally visible. This can be accomplished by temporarily
bring up the horizontal splitter exposing more of the tab, moving unwanted
fields there and then restoring the splitter to its normal location.

Using the Customizer, you can:

e Add new information fields

e Reposition information fields

e Relocated information fields to other tabs

e Incorporate images on a tab

e Set the sort algorithm used for an information field

e Specify if an information field is included as a search parameter



e Specify if an information field is allowed for data entry while copying
from the standard database

What defines an information field?

Each information field has several characteristics which must be defined:

e Field Label - this is the label to the left of the field which is also used
in column heading, searches, etc.

e Type of Data - this is used to connect the information field to a portion
of our database appropriate to the type of information to be stored.
Available types include:

(@]

o O O O O

Strings of various sizes from 8-1024 suitable for all alphanumeric
data

Integers

Currency - used for floating point numbers as wel

Date

Boolean - used for checkboxes

Calculated - fields which are populated based on a calculation of
up to 4 other fields

e Data Entry Object - the type of control used to enter data

(@]

o

Textbox - suitable for all data entry

Choice List — provides for choices which are automatically or
manually generated

Checkbox

Choice List-Linked, a choice list whose choices are dependent on
the selection of a parent choice list

e Sort Type - For searches and sorts, this defines the sorting algorithm.
Available choices are:

o O O O O

Alphabetic

Numeric

Assigned Value (for choice lists)

Special AD/BC - dating algorithm aware of AD/BC nuances
Special - US Coin Mint Mark - sorts based on common practice
where both blank and “P” are recognized as Philadelphia and
precede all other mints

Special - Mixed AlphaNumeric - sorts based on the numerical
content of a mixed field. For example A100B would be assigned
the value 100 for sort purposes



o Special -Grades - an algorithm specific to US Coin Grading
Display Format - used for numerical fields
Tab Assignment - fields may be placed on any of the available tabs
Item Detail - primary tab
More Detail — secondary tab
Buy/Sell - tab focused on transaction fields
Note - a large note
Estate - Estate planning fields

© O O O O

Common Customization operations

Note - for all move operations, you may specify a grid in inches (for
example .10) to which all items will be aligned

Reposition a field on its existing tab — click down on the label and drag
it around. Let the mouse button up when you reach the desired
position
Relocate a field to another tab
o Select the field by clicking on its label - the customizer should be
populated with its information. Select the desired tab in the
option button and then click on Move to Tab. (Note after moving,
you will likely need to reposition some of the fields on the
destination tab.
Select the tab to customize by clicking on it normally
Add a field by populating the form and then clicking on Add Field. The
field will be added to the currently selected tab, placed in the middle,
sometimes behind other fields. After addition it will be necessary to
reposition the field and perhaps other fields as well.
Delete a field, by clicking on its label and clicking on Delete Field. This
operation should not be used for fields which contain data.
Modify a field by selecting it, modifying its settings and clicking on
Modify Field. NOTE - if you change the Type of Data, any existing
collection data in this field will be lost.

Advanced Operations

Calculated fields - these fields require specification of the algorithm to
be used. Each algorithm is a mathematical calculation incorporating 1
to 4 other fields and operations such as “+”, *-","*” and “\". The user
may not enter data directly into these fields. Note - any fields used for



calculations must already exist. Also, if you modify these fields, you
will need to redefine the calculated field.
e Pictures - you may place up to 6 pictures across the tabs.

[ L S e e Pl S M O N e W T RS, o N NIRRT S i el Il

@ Data Entry Screens - Customize [ E ][]

ltem Detail | More Detsil | Buy & Sell | Mote | Pictures | Estate Planning

C'Ji"wpe -
. I = Catalog

Lo Data Enlry Sl::reen Customization

Coinagel| Data Entry Object Sort Type Display Format B Included as search field

® Text Box ® Alphabetic = M Include for user data entry
@ Choice List ) &

@ Check Box s e Dimensions (.01 inch)
@ Choice List-Linked | @ ¢ AD/BC Date @ Integer Top [ Height

@® Option Set S Coin M
@ Image Strip xed Alpha-h Left - wiath [N

@ RTF TextBox @ Special - Grades © ltam Detail © Ficture 0

@ More Detail @ PFicture 1

Modify Field | Moveto Tab-> e -
@ Note
Move Field Closer to Label Delete Field @ Pictures @ Ficiure 4

@ Estate S
SafoMode  © @ Fires
Alignment guide (inches)

Conversions (V5-V7)

This section is used for more precise control of conversion of data from
earlier versions and is not necessary for most users. The first time version 8
is run, it will search for older versions and if found, automatically convert
their data.



For users with special conversion requirements, this section allows for
individual conversion of:

e Choice Lists — On installation, the Collector’s Assistant populates the
standard Carlisle Development choice lists. If a user prefers to bring
theirs forward from earlier versions, this function will bring them into
V8

e Data Entry Screens - if the user has added data entry screens for new
collectibles or customized data entry screens, this function will bring
these into V8, overriding those supplied by Carlisle Development.

e Report Formats - override Carlisle’s standards

e Selected Collection - if you wish to manually convert a single collection

e All Collections - used to convert collections not found on initial running
of V8

e Value files - brings in old value files — not normally needed

e Standard Databases

o T I s
a- Conversions (V5-V7) )

Convenons of Data from Earlier Versions of the Collector's Assistant

You may replace the following items using those you customized in earlier
versions of the Collector's Assistant (V5-V7)

Identify location of older version

@ Value Files

Data Entry Screens [ Standard Databases

[l Report Formats
Selected Collections

[ All Collections




Chapter 7: Specialized Printed Reports

The Collector’s Assistant contains a second report generator for reports other
than columnar listings. This is used for such formats as flip inserts, index
cards, multiline reports and picture catalogs.

Each sheet of paper is divided into a number of rows and columns consisting
of rectangular areas. Within each rectangular area, the information on one
item will be presented. This area can contain any information fields as well
as pictures.

The definition of a report format is referred to as a Style. A number of
predefined Styles have been provided for common output media.

Select Report Style
index Card 3" by 5" E| Include Pictures

Strting Postion (onfca) e e |

Style Name | Style Dimensions | Picture Placement | Text Placement | Paper Size

New Style Nome
_Add Style Modify Style Name Delete Style

(Certified by) (Grade) (Lot Value)
(Country)
(Denomination)
(Date  (Mint)
(‘Coin Type)
(Coinage Metal)
(Variety)

Mintage: (Mintage)
Designer/Engraver: (Designer/Engraver)

(Inventory Code)




A report style defines both the content of a rectangular area as well as the
layout of rectangular area on a larger paper format.

For example, a standard 8 2 by 11" format consisting of three preperforated
5” by 3” index cards is one of the styles provided for most collectibles. Other
examples are flip inserts, labels and picture catalog pages.

Report Area Size by Include Header
# Rows per Page !ﬂ # Columns per Page Page # 0k

Spacing between rows Offset from top
| Mosiy Syte |
Spacing between columns XY g| Offset from left ¥

In the example shown there are 3 rows per page consisting of 1 column. The
offsets and dimensions are specified in inches.

Once a style is defined, the rectangular area can be populated with any of
the information fields and/or images for the current collectible.



: Text Placement : | Paper Size

............................................

Style Name | Style Dimensions | Picture Placement

Select field or enter fixed text - use %D for date. %P for page and %C for collection
I Y| @ Inciude Field Label
Maximum Field Width (inches) Maximum Field Height {inches)

| AddObject || Modify Object || Delete Object Change Color || Change Font

dinches — >

(Certified by) (Grade) (Lot Value)
(Country)
(Denomination)
(Date  (Mint)
(‘Coin Type)
(Coinage Metal)
(Variety)

Mintage: (Mintage)
Designer/Engraver: (Designer/Engraver)

(Inventory Code)

The text placement tab allows the user to add information fields and alter
the amount of space on the style to which any data will be limited. Fields
may be repositioned by dragging their labels around.

Two kinds of objects can be added to this style, information fields (with or
without their labels) and static text. Each object may be selected allowing
the user to modify its font, color, width and height. A colored box shows the
extent of the object, when presenting real data, any text outside of the box
will be truncated.



Chapter 8: Customizing Data Entry Screens

The Collector’s Assistant allows the user to customize the data entry folders
used to enter information about an individual item. For each collectible the
information fields are organized onto 3 tabs (Item Detail, More Detail and
Buy/Sell). These tabs are completely customizable, though changes must be
made with some care as data can be disconnected.

It is recommended that data entry screens be customized prior to the entry
of major amounts of data. Also, prior to customization, a backup should be
generated in the event it is necessary to undo the effects of an errant
customization.

What can be customized?

e Location of information fields on tabbed folders

e Moving a field from one tab to another

e Deleting an existing field

e Changing the label, width, etc of an existing field

e Adding new information fields

e Defining the data type (string, numeric, date) of an information field
e Defining the display format of an information field

What customizations should be avoided?

e Modifying field populated by a standard database other then simple
relocation onto another tab or repositioning on the current tab

e Changing the data type of a field which already contains user data as
this data will be disconnected

What does the customization process actually do?

e The Collector’s Assistant contains a large set of generic information
fields. The Data Entry screen contains objects such as choice lists,
check boxes, and text boxes which allow the user to enter information.

e The process of customization creates data entry elements and
associates them permanently with a field in the database.



Customizing Data Entry Screens — Relocate or Reposition

To move an information field during the customization process, right click on
its label and drag it around then let go of the mouse when you reach the
desired location

To move an information field to another tab:

e Click on the label of the field to select it (its information will field the
customizer)

e Select the tab to which it will be moved in the dropdown provided

e Click on the Move button

e Click on the tab to which the item was moved and reposition by
dragging its label around

Customizing Data - Adding a New Field

Select the tab to which the item will be added

e Fill out the form:
o Field Label (name of the field)
o Type of Data (string of x characters, integer, date, etc)
o Data Entry Object
» Text Box - used for entry of all kinds of data
» Choice List — user selects from predefined choices
» Check Box - Used with type of data Boolean
» Choice List-Linked - a choice list whose contents depend
on the choice of a parent list
= Option Set - a group of choices
Sort Type - selects among available sort algorithms
Display Format
Included as search field — adds this field to those available to the
search function

e Click on Add Field (the field will be added to the center of the tab)
e Reposition the field by dragging the label around (if the field is not
visible, it may be obscured by a large existing field occupying the

center of the tab, you may need to relocate that field first)



Customizing Data - Changing the distance between label
and associated entry object

Select the data entry object by clicking on its label

Click on either Move Field Closer to Label or Move Label Away from Field
as desired. Each movement is about .1 inch.



Chapter 9: Backup and Moving to a New Computer

Clicking on File->Backup will display the backup and restore window. This
window accesses four functions:

Backup - all customer data is copied into a user specified destination
drive and folder’

Prepare for Move to Another Computer — packages all files, both
program and data necessary to move to another computer in a way
such that no additional updates will be needed and copies the package
to portable media such as a memory stick or flash drive (1GB of free
space is recommended on the portable media)

Restore files from backup - used to copy individual collection files from
a previously generated backup

Load all files from another computer - this installs the prepackaged
files onto a new computer, both programs and data.

Note: The Collector’s Assistant backup function will not overwrite a pre-
existing backup. It is recommended that each time you do a backup you
click on Make New Folder and enter a name that provides useful information
regarding the backup such as Backup-May10-2010. Of course you may
manually delete an earlier backup, however retaining old backups increases
the likelihood that you will be able to recover from a data loss.

To use these functions:

Click on Select Folder in which to place the backup which will bring up
a file browser allowing you to select a destination.

Select the function

Click on Start Backup



Chapter 10: Collector Tools

The Collector’s Assistant includes a set of collector tools. Some are
appropriate to all collectibles and some are specific to coin collecting.

Available tools include:

e Collection Analyzer (tabular and graphical presentation)

©)
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Buy/Sell Effectiveness - comparison of profitability as a function
of seller

Want List - allows you to evaluate scenarios of acquiring wanted
items given a budget limit

Storage/Insurance Risk — provides information regarding
concentration of collectibles value as a function of location
History — provides summary trends of key collection data

e Grading Assistant — optional module separately purchased
e Coin image galleries

o

o

Coin Type Identification/Mint Mark Locator - displays all coins of
a given denomination with a graphics overlay indicating mint
mark location

Coin Variety Identification - displays magnified images of some
common varieties (large date/small date, near, far, etc) with
graphics overlays to point out the key features

Toned Coin Images - gallery of attractively toned images by

type

e Estate Planning - allows you to set up your heirs and liquidation
instructions as well as graphically view allocation by heir

e Insurance Planning — allows you to store blanket insurance information
and also view individually insured items

e Survival Manual (only if installed)

o O O O

o

Bullion Calculator
Crack-out Calculator
Grading Gallery
Grading History

Coin Viewing Animation
Image Gallery

e Top 100 Morgan (only of installed)

o

Varieties - displays the Top100 Morgan Varieties synchronized
with the currently selected coin



e Bullion Analyzer (only if installed) - this tool allows you to analyze the
bullion content of your collection, view historical bullion performance
and perform a variety of calculations relevant to bullion valuations.

Using the Collector Tools — Coin Image Galleries

Selecting any of these galleries will bring up an image viewing window with a
strip across the top representing the selected image set.

You may magnify an image by selecting it which will place a copy in the
larger box in the lower right portion of the window.

You may filter the displayed coins by selecting a denomination in the
dropdown provided in which case, only the coins of the selected
denomination will appear.

SloE|

Cent-Flying Eagle Obv Cent-Flying Eagle Rev Cent-Indian Head Obv Cent-Indian Head Rev Cent-Large Braided Hair Cent-Large Braided Hair Cent-Large Chain Obv Cent-Large Chain Rev

< i

Display Selected Pictures

Cent-Indian Head Rev

You can toggle the graphics overlay on/off by checking the checkbox labeled
“Display Graphic Overlays”

The option button allows you to move between the three galleries.



There is also a splitter bar between the image strip at the top and the
controls at the bottom which may be adjusted.

Using the Collector Tools — Insurance Planning

Selecting this option will display a small window used to enter information
about your insurance. You may enter and modify information about your
insurance policy in the fields provided and then click on Save Changes.

To see the value and insurance amount of individually scheduled items, click
on Update Scheduled Information. This will examine all items in all
collections and total the values and insured values of all items with an
insured value greater than 0.

Using the Collector Tools — Estate Planning



The Estate Planning window provides controls to manage your heirs and
provide guidance for liquidating your collection.

The top portion allows you to enter the names of your heirs, all of whom will
appear on the dropdown on the estate planning tab.

The bottom portion allows you to enter disposition names and detailed
instructions to be associated with items on the estate planning tab.

There is also a button Display Estate Summary which will display a table of
heirs and allocated value which may then be graphed and printed as a pie
chart.

=T

Display Estate Summary

=
|
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Using the Collector Tools — Collection Analyzer



The collection analyzer tools provide you with information useful to
evaluating your want list, storage risk and buying effectiveness. Data from
across all items in all collections is aggregated to assist you.

Clicking on any if the analyzer tools will open an analysis window. Each
analysis window contains a number of buttons and may contain some
parameters to feed the analysis

Controls:

e Display Results — produces a table with the desired analysis
incorporating parameters entered by the user
e Print - print the tabular results
e Graph Results — Displays another window with an appropriately
selected graphic presentation of the tabular data.
e Analysis specific parameters
o Want List
= Budget - the amount of money available to purchase
wanted items
» What to display and in what order
o Buy/Sell - no parameters
o Storage
= By Container or Location






Chapter 11: Report Composer

New to version 9 is the report composer. Enhancement of this feature will be
a major focus of future versions.

The Report Composer will appear either by clicking on any of the choices
under the Print menu (other than Print->Current Collection) or if you click on
the “Print” button at the top of the controls area, when no collection is open.

Clicking on any of the Print menu choices (All Collections or Selected
Collections) will display the Printing and Report Manager. This may be used
to select which collections will be included in the report and also to access
the Report Composer. Clicking on Preview and Print Collection Data will
display a preview window containing the selected data.

Clicking on Save Report as a PDF file will send the full output of the Report
Composer to the filename specified and placed in the folder
c:\CollectorAssistant\Reports\

Clicking on Report Composer will display the window allowing for user
selection of reporting parameters.



Prnnting & Report Manager (right click to close)

Select Report: Standard-Detailed EI

Collections to Include:

MName Selected Walue Cost Profit
» | Daollars | |SJDDD |SDE'D |SJD{)D

Grand Summaries

[s0.00 [50.00 [50.00

i ) Collector’s Assistant Report Hel
Update Collection Grid P P B8
The Collector's Assistant Report Manager is displayed either
Preview & Print Collection Data - B by clicking on any of the following main menu choices or
(no title/trailer sections) clicking on the “Print” button when no collection window is

open:
Save Report As a PDF File -
includes title and trailer sections s Print->All Collections {Detailed)
+  Print-=All Collections (Summary)
enter filename »  Print->Selected Collections (Detailed)




Printing & Report Manager (right click to close)

SIS Standard-Detailed B

Report Options
Page Width (inches): Include Detail W Landscape

Page Height (inches): 11.00 B g&igiﬁ:ﬁ%ﬁé’;‘i‘f page each ime

Owner (substituted for $O in report elements): _
Header Add Content

Footer

H Title Page(s) Include Table of Contents Add Content

Include Summary Page

M Trailer Page (s) Include Summary Page
Include Want List
Include Value Info

Save QuickReport
Delete QuickReport Hide Report Composer

Save Edits

The Report Composer allows the user to:

e Specify target page size

e Specify if detailed listings are included

e Specify landscape or portrait mode which is used for all portions of
the report containing detailed listing grids

e Specify header and footer presence and content

e Specify content of title pages including presence of a Table of
Contents and Summary Data

e Specify content of trailer pages including presence of summary
data, want list and most valuable items list

e Specify if a new page will be used at the start of each collection for
the primary detailed listings section of the report (Note-this will
only function if you drag the column heading Collection to the
group by area prior to generating the PDF file.

As mentioned the Report Composer will be an area of major enhancement
for future release both through the addition of precanned reports and user



defined sections, incorporating tables and graphs. We specifically welcome
feedback with regard to additional report sections. Please contact
support@carlisledevelopment.com with your ideas.
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Chapter 12: Collectible-specific information (Coins,
Paper Money, etc.)

e This section of the manual provide information specific to some of the
more common collectibles for which the Collector’s Assistant is used

Coins

Most information fields used on the standard data entry screens are self-
explanatory, others are described here:

e Numismatic code - these may be used for any purpose but are
commonly used for numbering systems employed for specific varieties
(Breen, Judd, VAM'’s, etc)

e Date Range - the starting and last years a coin type was issued

e Certified By - certification company

e # - unique number assigned to a certified coin

e Catalog and #: some users make references to specialized coin
catalogs for certain coins

e Inventory Code - used to enter or view a prefix to the automatic
unique number assighed to each coin if this feature is activated

Coin Grade Designations

There are a variety of designations added to the end of coin grades which
can greatly affect value. Common designations are:

e R, RB and B - used for color of copper coins (red, red-brown, and
brown) — this designation is commonly needed for mint state issues

e DC and C - deep cameo and cameo used for many recent issues (note
some certifiers use UltraCameo which is identical to Deep Cameo

e Varietal Designations such as F-full bell lines (Franklin Half Dollars)

Locating a coin in the database

Most circulating coins are easily located based on their denomination. For
example; Nickel-Buffalo, Quarter-Statehood, etc. Special database
categories include:



e Mint Sets, Proof Sets, and Prestige Sets - contain all annual
government issued sets

e Bullion-Gold, Bullion-Silver and Bullion-Platinum - contain American
Eagles, Gold Buffalo and UltraHighRelief St Gaudens

¢ Commemoratives and Commemoratives-Gold — Pre 1954 US
Commemorative issues

e Commemorative Modern and Sets - US Commemoratives 1982 to the
present. Commemorative Modern lists all coins individually.
Commemorative Sets lists those items which are sold sets and
represents an alternate way of cataloguing these items.

Coins - rolls and bags

The Collector’s Assistant includes a special feature for handling rolls and
bags. On the Item Detail tab, there is a field Units (Qty). This field contains
such entries as Roll (40 coin) or Bag (1000 coin). If this field is not blank,
the numerical portion is used as a value multiplier. For example, 3 50-coin
rolls would be catalogued as Qty 3, Units of Qty Roll (50 coin). The Lot Value
would be calculated as Qty * Numerical portion of Units of Qty * Unit Value.

Paper Money
Paper Money specific information fields which are not self-explanatory:

e Friedberg # - the standard numbering system used for identifying US
Paper Money.



Chapter 13: Troubleshooting

The Collector’s Assistant is designed to handle most unexpected error
conditions. Should the Collector’s Assistant behave in an unexpected way we
would recommend the following steps:

For new installations, which have never worked properly after installation:

e Right click on the Collector’s Assistant desktop icon
e Click on the Compatibility tab

e Check the box Run As Administrator

e Start the Collector’s Assistant

If that does not resolve the issue, contact Carlisle Development Corp
technical support using the contact information below.

For existing installations, which have previously been functioning

e Close the Collector’s Assistant

e Restart the Collector’s Assistant

e If the unexpected behavior no longer occurs, no further action is
needed.

o If the unexpected behavior recurs, it is recommended that you contact
Carlisle Development Corporation with a detailed description

Uninstallation/Re-installation is not recommended

Most unexpected behavior does not require reinstallation. This is usually a
needless waste of your time. Prior to taking these steps it is recommended
that you contact Carlisle Development technical support.

Further steps while awaiting a response from technical support

e Check to see if you are running the latest service pack
o Click on Help->About. The exact version humber and service
pack level will be indicated. Visit the Carlisle website and verify
that you are running the latest service pack and if not, install it.
o You will also find a list of corrected defects
e View the FAQ section which may provide answers to your
questions/issues



Auto Repair facility

Version 10 includes an automatic repair facility which can in some
instances correct problems. It also provides checkboxes to produce
additional diagnostic information which may be speed our ability to
resolve a problem.

If you encounter a problem, click on Help->Auto Repair and see if your
problem fits one of the three listed on the window that appears. If so click
on Fix Now to see if the problem is resolved.

If not:

e Check one of the Verbose... settings under error logging

¢ Use the Collector’s Assistant normally until the problem occurs

e Exit the Collector’s Assistant

e Email the file c:\CollectorAssistant\CAErrorLog.txt to
support@carlisledevelopment.com

o= Troubleshoot and Repair =N o ="

Troubleshooting & Repair

]

There are a few problems which may sometimes be easily resolved through this
automated repair facility. If you are encountering one of the listed problems. you
may attempt a Repair by clicking on Fix Now

Select the Problem you are encountering

TR

ollections have disappeared from the list

@ It is not possible to add items to one collection

@ Intermittent ermmor messages or loss of items stored

© Other
Autocorrect functionality is not available. close and restart the Collector's
Assistant and if the problem persists contact Techmical Support. Email

support@carlisledevelopment_com with as much detail as you can provide and
also attachthe file c-\CollectorAssistanf\CAEmorl og bxd

Fix Now L

Error Logging

© Only log identified ermors. clear all entries on starting Collector's Assistant (default i
@ Only log identified ermors, do NOT clear all entries on starting Collector's Assistan |
@ Verbose logging of both ermors and important operations - clear on start

@ Verbose logging of both ermors and important operations - do NOT clear on start




Contacting Technical Support
Technical support may be requested via e-mail or telephone.
E-Mail Support

E-mail is the recommended method for obtaining technical support as
responses are provided 7 days a week and it is the most effective way to
communicate detailed information and provide corrections if needed. E-mail
also eliminates issues caused by time zone differences.

E-mails should be sent to support@carlisledevelopment.com

Please describe your issue in detail as the more detailed description you
provide, the more likely we can provide a targeted resolution in our initial
response. E-mails without a detailed description result in a response
requesting more information which delays the ultimate resolution of your
issue. Also, for issues where a picture of what you are seeing may help, use
the PrintScreen key on your keyboard to take a snapshot of your monitor
which can be pasted into the e-mail or attached as a picture file.

Important — attach the file c:\CollectorAssistant\CAErrorlog.txt to your e-
mail as it may contain information relevant to the problem.

Telephone Support (978-369-4908)

Telephone support is available from 9:00-5:00 EST Monday-Friday. In most
instances you will reach a voice mail system. Please leave your nhame and
telephone number along with information on your availability. We strive to
return calls within 2 hours during our telephone support availability.

On request, we will try to accommodate scheduled calls at times other than
our standard hours.
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Appendix A - Altering the font size of the text on the tabbed folders

The text on all of the tabbed folders (labels on data entry fields and data
entry fields themselves) is set to a point size of 10 and all of the screen
designs are optimized for that size.

In Version 8.1.3, it is possible to adjust the font point size from 8 to 20,
most typically to increase the text size. This is accomplished under the
Colors choice under User Preferences. You can adjust the font size, Save
Changes and then exit and restart the Collector’s Assistant to have it take
effect.

If you do increase the font size, it is likely that some of the labels will
overlap with the fields to which they are attached and in some cases fields
also may overlap.

If overlaps do occur, the data entry customizer must then be used (in Safe
Mode) in order to reposition fields with adequate separation and also
increase the distance between labels and their associated fields. This can
usually be accomplished in a few minutes.

The required operations are found in the Data Entry Screen Customizer
under User Preferences. After selecting a collectible in the tree, its data
entry screens will display. You can then:

e Reposition a field by clicking down on its label and dragging it around
e Increase the separation between label and field by clicking on the label
and then the button Move Field Away from Label



Appendix B - Requirements for bullion value calculations
Bullion values will be calculated for all items meeting the following criteria:
Coinage Metal field:

e Begin with Gold, Silver, Platinum or Palladium followed by fineness
specified numerically. All of the following would work:

Silver .92

Gold 0.999

Platinum .95

Gold .999 Pure - Pure would be ignored

O

o O O

Weight:

A\ Py /4

e Begin with numerical value followed by word beginning with “o” or "O”

for ounce and “g” or “"G” for gram. All of the following would work:

o 1oz

o 1.0 ounce
o 10
o 1g
o 43.2Grams
o 13.2gr



